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The Shareware Concept
Shareware distribution gives users a chance to try software before buying it.    If you try a 
Shareware program and continue using it, you are expected to register.    Individual programs
differ on details -- some request registration while others require it, some specify a 
maximum trial period.    With registration, you get anything from the simple right to continue
using the software to an updated program with a printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright holder 
retains all rights, with a few specific exceptions as stated below.    Shareware authors are 
accomplished programmers, just like commercial authors, and the programs are of 
comparable quality (In both cases, there are good programs and bad ones!).    The main 
difference is in the method of distribution. The author specifically grants the right to copy 
and distribute the software, either to all and sundry or to a specific group.    For example, 
some authors require written permission before a commercial disk vendor may copy their 
Shareware.

Shareware is a distribution method, not a type of software.    You should find software that 
suits your needs and pocketbook, whether it's commercial or Shareware.    The Shareware 
system makes fitting your needs easier, because you can try before you buy.    Also, because 
the overhead and prices are low.    Shareware has the ultimate money-back guarantee -- if 
you don't use the product, you don't pay for it.

Association of Shareware Professionals
The Association of Shareware Professionals (ASP) is a trade association of shareware 
professionals who are dedicated to making the shareware concept work.    It sets standards, 
promotes the industry, and does all the things you would expect of a trade association.

Whenever you see the

ASP mark: <ASP>

            or logo:
                                                                                                 

 
you'll know that the program was produced by some who takes pride in his or her work.

The ASP also provides an alternate grievance path for you, the shareware user, in case you 
cannot resolve a problem with an ASP member.    To that end, the following standard 
message is provided in all ASP-certified software:
 

This program is produced by a member of the Association of Shareware 
Professionals (ASP).    ASP wants to make sure that the Shareware    principle 



works for you.    If you are unable to resolve a Shareware-related problem with 
an ASP member by contacting the member directly, ASP may be able to help.    
The ASP Ombudsman can help you resolve a dispute or problem with an ASP 
member, but does not    provide technical support for member's products.

Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442-
9427 USA, FAX 616-788-2765 or send a CompuServe message via CompuServe 
Mail to ASP Ombudsman 70007,3536.



Shareware Ombudsman Statement
This program is produced by a member of the Association of Shareware Professionals (ASP).   
ASP wants to make sure that the Shareware    principle works for you.    If you are unable to 
resolve a Shareware-related problem with an ASP member by contacting the member 
directly, ASP may be able to help.    The ASP Ombudsman can help you resolve a dispute or 
problem with an ASP member, but does not    provide technical support for member's 
products.

Please write to the ASP Ombudsman at 545 Grover Road, Muskegon, MI 49442-9427 USA, 
FAX 616-788-2765 or send a CompuServe message via CompuServe Mail to ASP 
Ombudsman 70007,3536.

 

                                                                     
 



Company Defaults
The company name that you enter in the New Company    or Maintain Company Information 
screens is displayed in the title bar    at the top of the screen when you open a company for 
processing.    The company name will also appear on various reports that may be generated 
for the current company.    Other organizational information such as street address, city, 
state, and zip code may also be printed.



Member Defaults
By choosing the Default Information, Members option from the Maintain menu you can 
enter the application defaults for the membership module.    Five types of default information
may be defined:

1. Required Fields - These options can be used to enforce an organization's data entry
rules regarding certain member data items.    For example, social security number can
be selected as a required field.    In this case, a member record cannot be saved to 
disk if a social security number either has not been entered or has been removed.

The following fields can be selected as required data items:

Gender
Status
Marital
Relation
Social Security Number
Date of Birth
Envelope #
Registry #

 2. Status Codes - There are 10 pre-defined membership status codes available:

Contact
Contributor
Deactivated
Deceased
Guest
Inactive
Member
Prospect
Shut-in
Visitor

You can define up 10 additional user-definable membership status codes for 
classifying an individual's affiliation or connection with your organization.

3. Additional Phones - You can define up 10 user-definable phone numbers.    
Examples: Fax, Pager, Cellular, In Case of emergency.    

4. Event Dates - You can define up to 10 user-definable event dates.    Examples: 
Wedding, Joined, Baptism. 

5. Custom fields - You can define up to 12 user-definable custom fields.    Examples: 
Blood Type, Hobby, Special Skill.

NOTE: User-definable fields are stored in the database based on the order of their label 
description defined on the Member Defaults screen.    What this means to you is that 
once a label description has been defined, don't move it to a different # location.    Also, 
once you have entered information into the database for these fields, deleting or 
renaming one of the user-definable label descriptions on the Member Defaults screen 
doesn't mean that the information will be changed in the actual fields of the database 
records.





License
X-Ware Engineering is delighted that you are trying Membership DataBank for Windows and 
distributing it to your friends, colleagues, and BBS's!    If you find Membership DataBank for 
Windows useful, register it.    If you distribute it, please distribute only the unregistered 
version and keep all the files together. 

Please show your support for Shareware by registering the programs you actually use and by
passing the unregistered versions on to others.

Shareware is kept alive by YOUR support!

Trial Use License

Membership DataBank for Windows is provided at no charge for evaluation purposes 
only.    This Shareware version of Membership DataBank for Windows is the complete 
working version of the product, not a crippled or demo copy.    Membership DataBank 
for Windows    is not    public domain software. It is Copyright (c) 1995 by X-Ware 
Engineering. All rights reserved.

X-Ware Engineering hereby grants you a limited license to use this software for 
evaluation purposes only for a period not to exceed sixty (60) days.    If you intend to 
continue using this software (and/or its documentation) after the sixty (60) day 
evaluation period, you must make a registration payment to X-Ware Engineering.    
Using this software after the evaluation period has ended without registering is a 
violation of the terms of this limited license.

Licensee shall not use, copy, rent, lease, sell, modify, decompile, disassemble, 
otherwise reverse engineer, or transfer the licensed software except as provided in 
this agreement. Any such unauthorized use shall result in immediate and automatic 
termination of this license.

All rights not expressly granted here are reserved to X-Ware Engineering. 

U.S. Government Restricted Rights:    Use, duplication, or disclosure by the U.S. 
Government of the computer software and documentation in this package shall be 
subject to restrictions as set forth in subdivision (b) (3) (ii) of the Rights in Technical 
Data and Computer Software clause at 252.227-7013 (DFARS 52.227-7013).    
Manufacturer is X-Ware Engineering, 968 Admiral Callaghan Lane, Suite 357, Vallejo, 
CA 94591-3680.

Registered Use License

X-Ware Engineering hereby grants to you as an individual, a personal, 
nontransferable license to use    the Membership DataBank for Windows product for 
personal use in your business or profession. 

 
This Shareware version of Membership DataBank for Windows is the complete 
working version of the product, not a crippled or demo copy.    Membership DataBank 
for Windows    is not    public domain software. It is Copyright (c) 1995 by X-Ware 
Engineering. All rights reserved.



You may use the licensed software at a single location on a single computer which 
you own or use and for which the software was designed to operate.    Unless you 
have licensed a network version of the software, you may not use the software in a 
network or a multiple user arrangement.    If you have licensed a network version of 
the software, you have the right to use the network version only on a local area 
network established    by you at a single location, and the software may be accessed 
only by your employees or by other authorized personnel working for you at such 
location .

You may not make copies, translations or modifications of or to the software, except 
you may copy the software for backup purposes in support of your use of the 
software.

Licensee shall not use, copy, rent, lease, sell, modify, decompile, disassemble, 
otherwise reverse engineer, or transfer the licensed software except as provided in 
this agreement. Any such unauthorized use shall result in immediate and automatic 
termination of this license.

All rights not expressly granted here are reserved to X-Ware Engineering. 

U.S. Government Restricted Rights:    Use, duplication, or disclosure by the U.S. 
Government of the computer software and documentation in this package shall be 
subject to restrictions as set forth in subdivision (b) (3) (ii) of the Rights in Technical 
Data and Computer Software clause at 252.227-7013 (DFARS 52.227-7013).    
Manufacturer is X-Ware Engineering, 968 Admiral Callaghan Lane, Suite 357, Vallejo, 
CA 94591-3680.

Limited Distribution License

This Shareware version of Membership DataBank for Windows is the complete 
working version of the product, not a crippled or demo copy.    Membership DataBank 
for Windows    is not    public domain software. It is Copyright (c) 1995 by X-Ware 
Engineering.    All rights reserved.

X-Ware Engineering encourages you to freely copy and distribute this unregistered 
version of Membership DataBank    for Windows subject to the following restrictions.    

 
Permission is granted to individuals charging no fees, and to BBSes, User Groups, 
Mail-Order Disk Vendor, CD-ROM publishers, and BBS File-Distribution Networks 
regardless of fees, to distribute the Membership DataBank for Windows package, 
provided they convey a complete and unaltered copy of the shareware version of this
product, and provided they claim no ownership of these products.

Distribution by other channels, and distribution of modified versions, are also 
allowed, but only under the terms of the attached VENDINFO data record, which is 
hereby incorporated by reference.    Any distribution satisfying all the distribution 
requirements expressed in that data record is hereby authorized.

 Permission to distribute these products is not transferable, assignable, saleable, or 
franchiseable.    Each vendor wishing to distribute these products must independently
satisfy the terms of this limited distribution license.

Licensee shall not use, copy, rent, lease, sell, modify, decompile, disassemble, 
otherwise reverse engineer, or transfer the licensed software except as provided in 



this agreement.    Any such unauthorized use shall result in immediate and automatic 
termination of this license.

All rights not expressly granted here are reserved to X-Ware Engineering.

X-Ware Engineering may revoke any permissions granted here, by notifying you in 
writing.

U.S. Government Restricted Rights:    Use, duplication, or disclosure by the U.S. 
Government of the computer software and documentation in this package shall be 
subject to restrictions as set forth in subdivision (b) (3) (ii) of the Rights in Technical 
Data and Computer Software clause at 252.227-7013 (DFARS 52.227-7013).    
Manufacturer is X-Ware Engineering, 968 Admiral Callaghan Lane, Suite 357, Vallejo, 
CA 94591-3680.

Limited Warranty

 X-WARE ENGINEERING SPECIFICALLY DISCLAIMS ALL IMPLIED WARRANTIES ON THE 
SOFTWARE AND MANUALS, INCLUDING, WITHOUT LIMITATION, WARRANTIES OF 
MERCHANTABILITY, PERFORMANCE AND FITNESS FOR A PARTICULAR PURPOSE.    
NEITHER X-WARE ENGINEERING NOR ANYONE ELSE INVOLVED IN THE CREATION, 
PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL BE LIABLE FOR ANY BUG, 
ERROR, OMISSION, DEFECT, DEFICIENCY OR NONCONFORMITY IN ANY SOFTWARE.    
AS A RESULT, THE SOFTWARE IS SOLD "AS IS" AND THE PURCHASER ASSUMES THE 
ENTIRE RISK AS TO ITS QUALITY AND PERFORMANCE.

 
NEITHER X-WARE ENGINEERING NOR ANYONE ELSE INVOLVED IN THE CREATION, 
PRODUCTION, OR DELIVERY OF THIS SOFTWARE SHALL IN NO EVENT BE LIABLE FOR 
DIRECT, INDIRECT, SPECIAL, INCIDENTAL, CONTINGENT OR CONSEQUENTIAL 
DAMAGES RESULTING FROM ANY DEFECT IN THE SOFTWARE OR ITS DOCUMENTATION
INCLUDING DAMAGES FROM LOSS OF DATA, DOWNTIME, LOSS OF GOODWILL, 
DAMAGE TO OR REPLACEMENT OF EQUIPMENT OR PROPERTY, EVEN IF X-WARE 
ENGINEERING HAS BEEN ADVISED OF THE POSSIBILITY OF SUCH DAMAGES.    You 
agree that X-Ware Engineerings' liability arising out of contract, negligence, strict 
liability in tort or warranty shall not exceed any amounts paid by you for this product. 
Any written or oral information or advice given by X-Ware Engineering dealers, 
distributors, agents or employees will in no way increase the scope of this warranty, 
nor may you rely on such oral or written communication.    Some states do not allow 
the exclusion or limitation of implied warranties or liability for incidental or 
consequential damages, so the above limitation or exclusion may not apply to you.    
This warranty gives you specific legal rights, and you may also have other rights 
which vary from state to state. The laws of the State California shall govern this 
Agreement.



Introduction
Membership DataBank for Windows is a Microsoft Windows based non-profit accounting 
system that lets you manage information concerning the financial condition and operating 
performance of your group or organization.    It has been designed to serve the needs of all 
types of non-profit organizations. Membership DataBank for Windows uses terminology that 
all users can quickly understand without having to have any professional experience of 
similar computer software.    All that is required is a basic knowledge of the Microsoft 
Windows operating system. Membership DataBank for Windows provides the following 
facilities:

- Membership administration
- Household administration
- Label printing facilities
- Reporting facilities

These facilities are provided by means of an easy to use menu system with extensive use of 
standard button tool bars and special function keys for easy selection.    A context sensitive 
help system ensures that whenever you are not sure about anything, you can simply press 
the F1 help key and a help screen will appear explaining clearly what is required at that 
particular point and what you should do next.

X-Ware Engineering has gone to great lengths when designing this product to ensure that 
user-defined entries and    information categories in Membership DataBank for Windows let 
you track the data that is specific to your situation, without the use of complicated 
numbering schemes.    The program's many user-defined fields let you shape the program for
use in widely different organizations.



System Requirements
In order to setup and operate Membership Databank for Windows successfully, your 
computer system must meet the following minimum system requirements:

Hardware - Personal computer (IBM PC, PS2, or 100% compatible)
- 486sx or higher microprocessor
- 8 MB of memory (16 MB recommended)
- 6 MB free disk space (10 MB recommended)
- One 3.5" high-density disk drive
- Microsoft Mouse or compatible pointing device
- Any Microsoft Windows supported printer
- VGA or higher-resolution monitor recommended

Software - MS-DOS operating system version 3.1 or later
- Microsoft Windows operating system version 3.1 or later
( running in 386 enhanced mode )

Network - Microsoft Windows For Workgroups 3.11 or later
- Microsoft Windows NT
- Novell NetWare
- Lantastic NOS
- Other NetBIOS compatible networks

In addition, ensure that your C:\CONFIG.SYS file contains the command FILES=60 or above 
to avoid experiencing the error message "Too Many files Open". If you wish to have several 
Windows applications open simultaneously, you may need to increase this value to 100 or 
more.



Using X-Ware Engineering Software
X-Ware Engineering software is designed to be powerful, yet easy too use. A number of 
features have been developed to allow you to record and access all your information with 
minimum effort. Some of these features are described below.    They include:

Easy to use menus

         

Wherever you are in the Membership DataBank for Windows application, you will 
generally see a menu bar along the top of the screen under the Title bar.    When you 
select any of these options, a pull-down menu appears listing choices for the Main 
Menu option.    If one of these options is dimmed , this means that it is not active for 
that particular program function.    Membership DataBank for Windows automatically 
updates the menu bar depending on the program functions.

For further information on the use of menus, see your Microsoft Windows manual.
 
 
Standard button tool bar

Membership DataBank for Windows    employs the use of toolbars to provide you quick 
access to program functions.

                             

The parent window Toolbar    is just below the Menu Bar .    This is a unique button bar 
that allows quick access to program functions that are common to all windows.

           

The data entry window Toolbar    is just below the Title Bar .    This is a unique button 
bar that allows quick access to program functions that are specific to the data entry window.

These toolbars are specially designed to be easy to locate and use by    a picture and/or
text describing what the button does.

Special function keys

 
Context sensitive help
 



Membership DataBank for Windows has been designed to provide context sensitive 
help.    Context sensitive help gives you immediate help with a screen element of 
interest (menu command, dialog box, etc.).      Membership DataBank for Windows 
takes you directly to the help information you seek without the need to traverse the 
online help indexing system.    Anytime you would like to access the context sensitive 
help feature, simply press F1 key or the appropriate Help button.

NOTE: To get help on a specific menu command, click the menu name and then use 
the Down Arrow Key to highlight the command of interest.    Once the command is 
highlighted, press F1.



Membership DataBank for Windows - In Detail
X-Ware    Engineering is delighted to present to you Membership DataBank for 
Windows.    This product is a    Microsoft Windows based non-profit accounting system that 
lets you manage information concerning the financial condition and operating performance 
of your group or organization.    It has been designed to serve the needs of all types of non-
profit organizations.

Contents
    

Getting Started
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Determine General Defaults
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Members

Reference
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company name
You can enter up to 30 characters for the company name. The name displays on reports so 
use your company's correct and legal name.    



address
You can enter the address in two lines which can contain up to 30 characters each.



city, st, zip
Three boxes on this line represent the city, state, and zip code, respectively.

· You can enter up to 20 characters for the city.
·

· Enter the two-character postal abbreviation for you state.
·

· enter the zip code. 



telephone
you can enter up to 20 characters for the telephone number.



fax
You can enter up to 20 characters for the Fax number.



federal employer ID
You can enter up to 11 characters for the federal employer ID.    The federal employer ID is 
required by the Internal Revenue Service.



state employer ID
You can enter up to 11 characters for the state employer ID.    The state employer ID is 
required by most states' department of revenue.



state unemployment ID
You can enter up to 11 characters for the state unemployment number, if required by your 
state.



first name
You can enter up 15 characters for the first name of a member.



employer name
You can enter up to 30 characters for the company name. The name displays on reports so 
use your employer's correct and legal name.    



address
You can enter the address in two lines which can contain up to 30 characters each.



city, st, zip
Three boxes on this line represent the city, state, and zip code, respectively.

· You can enter up to 20 characters for the city.
·

· Enter the two-character postal abbreviation for you state.
·

· enter the zip code. 



telephone extension
You can enter up to 4 characters for the telephone extension number.



fax
You can enter up to 20 characters for the Fax number.



position
You can enter up to 30 characters to describe a member's work position or job title.



telephone 
you can enter up to 20 characters for the telephone number.



family name
You can enter up to 40 characters for the family name of a household.    Membership 
DataBank for Windows uses the family name when addressing correspondence to a 
household.



address
You can enter the address in two lines which can contain up to 30 characters each.



city, st, zip
Three boxes on this line represent the city, state, and zip code, respectively.

· You can enter up to 20 characters for the city.
·

· Enter the two-character postal abbreviation for you state.
·

· enter the zip code. 



head of house
This is a display (view only) field.    The head of house can only    be assigned or changed via 
the Household menu.



telephone
you can enter up to 20 characters for the telephone number.



date of birth
This is a numeric field that must be entered as MM/DD/YYYY.    Example: 01/01/1995.



gender
you can enter up to 7 characters for describing the gender of a member.



label name
You can enter up to 40 characters for a label name for a member.    Membership DataBank 
for Windows uses the label name when addressing correspondence to a member.



last name
You can enter up to 20 characters for the last name of a member.



marital status
You can enter up 10 characters for describing the marital status of a member.



membership status
You can enter up to 12 characters for describing the membership status of a 
member/prospect.



middle name
You can enter up to 10 characters for the middle name of a member.



preferred name
You can enter up to 15 characters for the preferred (nickname) name of a member.



relation
You can enter up to 12 characters for describing the relationship of a member to the Head 
Of Household.



registry number
You can enter up to 8 characters for assigning a member a registry number.



suffix name
You can enter up 11 characters for the suffix name of a member.



Social Security Number
This is a numeric field that must be entered in the format 999-99-9999.    Example: 123-45-
6789.



envelope number
You can enter up to 8 characters for the envelope number of a member.



title
You can enter up 10 characters for the title of a member.



Advanced Tips And Tricks
1. All Membership DataBank data entry forms are initially displayed in the view mode.    

You must press the    Edit button to place the form in the edit mode before you are 
allowed to make any changes to the data that is displayed.

2. When a member is moved from one household to another, all of that member's 
associated information moves with them (contributions, attendances, etc.).

 
3. Optimistic Buffering: Membership DataBank's database engine uses aggressive 

optimistic buffering    schemes.    The basic philosophy behind optimistic buffering is 
that all file reads and writes are cached as long as possible.    This allows the database 
engine to visit a memory buffer for information instead of reading from or writing to 
disk.    Besides speed benefits there are other subtle benefits that save on system 
resources.

Caveats for Optimistic Buffering: Membership DataBank's database engine does 
not detect if a LOCAL hard drive is a shared volume under a peer to peer network, such
as Windows for Workgroups or Windows 95.    If Membership DataBank is installed on 
your LOCAL hard disk and is being accessed by users logging into your local machine, 
turn Optimistic Buffering off.

NOTE:    You can turn optimistic buffering off by placing the following parameter in 
the [AppEnv] section of the MDW.INI file located in the Windows directory:

SetOBuffer=0



Registration
 

              

        

        

 

This product is Shareware and as such it should be registered with X-ware Engineering if you 
intend to continue using it after the initial 60 day evaluation period. In order to register the 
product you should use Microsoft Windows Write to access the required registration form 
relevant to the country in which you live. The following forms are available.

REGISTUS.WRI - USA

Icons for these forms should have been setup in your program manager group when you 
installed Membership DataBank for Windows.    Double-click the relevant icon to edit the 
registration form, or enter the following command at the program manager File, Run option:

WRITE C:\MDBANK\REGISTUS.WRI

Registrations are accepted by mail, email, and fax. Payments may be made by check, VISA, 
MASTERCARD, AMERICAN EXPRESS, and DISCOVER or CompuServe users may use the 
CompuServe service GO SWREG to register on-line and have the registration fee directly 
debited from their CompuServe account. Further registration instructions and pricing details 
can be found on the forms listed above.

Registration Benefits
By registering this package with X-Ware Engineering, you become eligible for the following:



- a registration number to remove all "on evaluation" screens and messages
- a copy of the latest version of this product
- lifetime support for written correspondence
- written notification of at least the next 2 major upgrades
- immediate notification of major bugs found with the registered version
- package and shipping costs only for release to fix reported problems
- opportunity to provide input towards development of future releases
- opportunity to request customization of system unique to your company

Remember - Shareware is based on your honesty. If you like this product and you continue to
use it after your initial evaluation, then you should register it. If you do not register after the 
evaluation period you are breaking the license agreement and should discontinue to use the 
product.



Technical Support
X-Ware Engineering is committed to providing the finest technical support available. In order 
to do that, we need your help.    To make optimal use of our technical support, follow the 
procedures outlined below.

Technical Support Policy
X-Ware Engineering offers free technical support and problem resolution to all 
registered users of our software as detailed in the registration section of this help 
system. Our support service can help you with any questions you may have about our 
software and help you fix any faults you may find. Also, an important part of our 
support service is to provide you with an opportunity to give us feedback about our 
products so that future upgrades can be designed better to suit your requirements.

How To Become a Registered User
Register Membership DataBank for Windows using the appropriate registration form 
included with this product.    These forms record your name, address, company name, 
phone and fax number, any electronic mail or BBS numbers.    The registered user must
be the person using the software and calling for technical support -- not the software 
librarian of the company.

Later in this section we will explain in detail the information to include about your 
problem.

 

Asking us Questions
We like to provide detailed and accurate answers to all your questions about 
Membership DataBank for Windows.    We request that you send us your detailed 
questions by Internet, CompuServe, Fax, or U.S. Mail, instead of calling us.    
This allows us to investigate your questions in detail and have them answered by 
experts in the specific areas.

Contacting Us
Technical support is available, in order of priority, by:

-    Internet
-    CompuServe
-    Fax
-    Mail
-    Phone

Internet
The best way to get technical support is through the Internet.    It is available to you 24 
hours a day, seven days a week.    Our Internet mailer checks for new mail every 10 



minutes.

Log into the Internet and send a message to X-Ware Engineering's email address:

support@x-ware.com 
 
 
CompuServe

The second best way to get technical support is through CompuServe.    It also is 
available to you 24 hours a day, seven days a week.    We check X-Ware Engineering 
CompuServe mail twice a day, six days a week.

Log into CompuServe and send a mail message to X-Ware Engineering's ID:

102621,2065

Fax
You may reach X-Ware Engineering by fax 24 hours a day, seven days a week.    Our fax
number is:

707-557-2078

When you fax, please include your name, address, and phone and fax number.    This 
information must match the information on your registration form.

Phone
We rarely resolve anything on the phone.    If you call and say "My application does not 
work," there is nothing we can do or suggest to help you without reviewing your 
problem, and that takes more than a quick call.

The fastest, most efficient way to get technical support is through CompuServe.    Send 
us a complete working copy of your installation and describe your problem in detail 
before you call.    Then when you do call, we can have your answers ready.

Use the same procedure if you send your information to our bulletin board, by fax, or 
by mail.

You must be a registered user before you call!    Before you call:

-    Read any README files on your Membership DataBank for Windows disks.

X-Ware Engineering technical-support hours are Monday through Friday 9:30 AM to 
4:30 PM Pacific time.    Please have this information when you call:

-    The name of the registered Membership DataBank for Windows user
-    Your Name
-    Your company name
-    The version of Membership DataBank for Windows you are using
-    The operating system you are using



-    The serial number of Membership DataBank for Windows you are using

The next section goes into detail about additional information we may also need to 
pinpoint your problem.

When you call, be in front of your system and ready to try any commands.

If you miss us or we are helping other customers when you call and need to leave a 
message, here is a sample message:

"I need technical support on Membership DataBank for Windows    version x.xx
(where x.xx =    the version of the product that you are 

using) .
My name is __________.
My company name is __________.
The best time to reach me is __________.
My phone number is __________."

The X-Ware Engineering Technical Support Hotline is:

707-557-2078

What Information Will We Need ?

Please provide the following information when you contact us for technical support:

-    Your full name
-    Your address
-    Your company name
-    The phone number and the best time to reach you
-    The version of Membership DataBank for Windows you are using
-    Your operating system

Describing The Problem

-    As precisely as you can, give us the exact details about the problem(s)
      and/or errors    that you are experiencing.

-    List any error messages that appear in connection with the problem.

 We Will also need to know

-    What your config and autoexec files contain?
-    What version of DOS and Windows are you running?
-    The make and model of your machine and video driver.
-    Amount of memory.
-    List any other devices and peripherals in your system.

If we cannot duplicate a problem, we cannot fix it

-    Provide us with as detailed a list as possible of the steps and conditions
      we will need to recreate the problem?

-    If a problem is intermittent, please describe as well as you can the machine



      and conditions just before it occurred.

TECHSUP.WRI

To process your technical support request as efficiently as possible, we ask that you fill 
out X-Ware's technical support form.    You will find a copy of this form in a Microsoft 
Write document in a file named TECHSUP.WRI in your Membership DataBank for 
Windows program directory.    



Software Upgrades
All registered users of this product will be informed when upgraded versions of the product 
become available as detailed in the registration section of this help system. Details of new 
and improved features in the product will be published and registered users will be given the
option of upgrading at a significant discount from the full registration cost.

Future upgrades planned for Membership DataBank    for Windows include the following:

-    Access Authorization
-    Membership Administration
-    Contributions
-    Pledges
-    Fund Accounting
-    Encumbrance Accounting
-    Accounts Payable
-    Bank Reconciliation

Please note that all of these facilities cannot possibly be included in the next 
upgrade and further improvements will be included which have not been listed 
here. Our upgrade program will, however, ensure that the facilities most 
requested by our REGISTERED users are the first to be developed. 



Help Menu
The Help Menu lets you:

· Access help from the Contents.

· Search for a help topic.

· Find out about Using Help.

· Display product and license information (About   Membership DataBank for Windows  ).



Maintain Menu
The Maintain Menu lets you:

· Add, change, and delete member information.

· Add, change, and delete company information.

· Set and define membership defaults.



Adding a New Member
To add a new member:

1. Select Member/Prospect from the Maintain menu. The Maintain Member 
Information data entry screen will be displayed.

2. Click the New button on the data entry toolbar.    The Maintain Member Information 
data entry form will be placed in the edit mode and all fields will be cleared.

3. Fill in the fields on the Member Tab.

4. Click the Household tab.    The household fields will be displayed.

NOTE:    Membership DataBank    for Windows requires that all members belong a 
household.    You must either assign the new member to an existing household or 
create a new household for the member.

5. When you're finished filling in all the information, click the Save button on the data 
entry toolbar.    A new member record will be created and if appropriate, a new 
household record and/or a new employer record will be created.

                      



Changing Member Information
To change member information:

1. Select Member/Prospect from the Maintain menu. The Maintain Member 
Information data entry screen will be displayed.

2. Use the Data Control buttons or the Find button on the data entry toolbar to locate 
the member you want to change.

3. Click the Edit button on the data entry toolbar.    The Maintain Member Information 
data entry form will be placed in the edit mode .

4. Change fields or fill in the fields on any of the Maintain Member Information tab 
sections.

 
5. When you're finished changing or filling in all the information, click the Save button 

on the data entry toolbar.    The changes to the member record and any related 
records will be saved to disk.

                      



Delete a Member
To delete member information:

1. Select Member/Prospect from the Maintain menu. The Maintain Member 
Information data entry screen will be displayed.

2. Use either the Data Control buttons or the Find button on the data entry toolbar to 
locate the member you want to delete.

3. Once you have located the member you want to delete, click the Delete button.    All 
information the member will be deleted from the membership database.

                  



Move a Member to a New Household
To move a member to a new household:

1. Select Member/Prospect from the Maintain menu. The Maintain Member 
Information data entry screen will be displayed.

2. Use the Data Control buttons or the Find button on the data entry toolbar to locate 
the member you want to move to a new household.

3. Click the Edit button on the data entry toolbar.    The Maintain Member Information 
data entry form will be placed in the edit mode .

4. Click the Household tab to display the member's household information.
 

5. Click the Menu for Households button on the bottom of the page.    The household 
menu will be displayed.

6. Click the Pick new household for this person menu item.    The Search for Head of
Household browse screen will be displayed.

7. Locate the new household for the member using the browse screen.    When you have
highlighted the new household that you are assigning the member, click the Ok 
button on the browse screen toolbar.    The member's household information will be 
updated to reflect the new household assignment.

8. Click the Member tab of Maintain Member Information data entry screen.    Change 
the Relation field to reflect the member's relationship to the new head of house.

9. When you're finished changing or filling in all the information, click the Save button 
on the data entry toolbar.    The changes to the member record and any related 
records will be saved to disk.

                      



Search for a Member
When the Maintain Member Information screen is initially displayed it shows the information 
on the first    member in the membership database.    You will need to position the database 
to the member you to view or change.    You can position the database using the data control
buttons on the data entry toolbar (see toolbar summary on data entry window).    You can 
also search for a member using a browse screen.    The instructions below describe how to 
search for a member using a browse screen.
    
To search for member:

1. Select Member/Prospect from the Maintain menu. The Maintain Member 
Information data entry screen will be displayed.

2. Click the Find button on the data entry toolbar.    The Search for Member browse 
screen will be displayed.    The browse screen displays members in alphabetic order 
by last name.

3. Select the member    you want to view or edit.    If necessary, use the scroll bar to see 
more members.    

4.  Click the Ok button.            



Comments
This tab is where you enter notepad comments pertaining to a member.    A member 
comment notepad is capable of storing 64.000 characters of notepad information.



Employer
This tab is where you enter information about the employer of a member such as employer 
name,    address, city, state, zip code, and phone number.

Fields
Employer
Address
City, St, Zip
Position
Telephone
Telephone Extension
Fax Number



Household
This tab is where you enter information about the location of the household residence such 
as head of house,    address, city, state, zip code, and phone number.

Fields
Head of House
Family Name
Address
City, St, Zip
Telephone

Pop-up Menu
Display household summary information
Assign this person as head of household
Pick new household for this person
Create new household for this person



Member
This tab is where you enter information about the member such as name,    gender, marital 
status, social security number, and date of birth.

Fields
Title
First name
Middle name
Last name
Suffix name
Preferred (nickname) name
Label name
Gender
Member status
Marital Status
Relation
Social Security Number
Date of Birth
Envelope Number
Registry Number



Profiles
This tab is where you enter information about a member's profiles such as additional phone 
numbers, special event dates, other information as defined by your organization.

Fields
Additional Telephones
Special Event Dates
Custom Fields



Other Products And Services
 
The following software is available from X-Ware Engineering.    Please contact your shareware
distributor for further product information.

Membership DataBank for Windows

A Microsoft Windows based non-profit accounting system that lets you manage information 
concerning the financial condition and operating performance of your group or organization.

Services

X-Ware Engineering offers custom application development services using state-of-the-art 
development tools and methodologies.    We also provide services for converting to 
Membership DataBank for Windows.    Please call or write for further details.



Menu Bar
The Menu Bar is the horizontal list of menus that is located directly beneath the title bar.    
Each menu item's name has one underlined character, which is referred to as a mnemonic.    
Type the mnemonic letters for keyboard access to menu items.

the items on the menu bar are:

F  ile          E  dit          M  aintain          R  eports          O  ptions          W  indow          H  elp  

When selecting an item from a menu,    visual clues tell you what will happen next.

An item followed by no marking starts an action .

An item followed by an ellipsis (...) opens a dialog box.

An item followed by an arrow (>) opens a cascading menu.



Edit Menu
The Edit Menu lets you:

· Copy text to the clipboard.

· Cut text to the clipboard.

· Paste text from the clipboard.



File Menu
The File Menu lets you:

· Open an existing company.
· Create a new company.
· Delete an existing company.
· Setup a printer.
· Exit Membership DataBank for Windows.



Options Menu
The Options Menu lets you:

· Turn the Toolbar on and off.

· Turn the Status Bar on and off.



Reports Menu
Use the choices on the Reports menu to generate reports on members.

Use this menu choice... To do this...

Family Directory Display/Print    a report of all household names in the 
membership database.    Report includes household address and
telephone.

Family Mailing Labels (2-up) Display/Print mailing labels for all households in the 
membership database.    Use for addressing correspondence to 
families.

Family Mailing Labels (3-up) Display/Print mailing labels for all households in the 
membership database.    Use for addressing correspondence to 
families.

Member Directory Display/Print a report of all members in the membership 
database.    Report shows member name, address, home phone,
and social security number.

Member Mailing Labels (2-up) Display/Print mailing labels for all members in the 
Membership database.    Use for addressing correspondence to 
individual members.

Member Mailing Labels (3-up) Display/Print mailing labels for all members in the 
Membership database.    Use for addressing correspondence to 
individual members.



Window Menu
The Window Menu lets you:

· Cascade multiple document windows.

· Tile multiple document windows horizontally or vertically.

· Arrange your desktop.



Software Bugs
This software has been produced and tested with a great deal of care and attention to detail.
Every effort has been made to ensure that the product works correctly as specified in the 
user guide. Rigorous testing has been done to ensure that the product operates properly in a
wide variety of different types of organizations.

However, as with any software product, you may find that problems occur under certain 
circumstances which we could not test for. In these cases, we will endeavor to fix any errors 
reported to us in writing. In order that we can help as quickly as possible, it would be useful 
to send a copy of your data along with a detailed description of how the problem can be 
replicated.



Company
Membership DataBank for Windows allows you to create and access multiple companies.    
All companies have their own set of data files,    stored in their own sub directory underneath 
the directory you told Membership DataBank for Windows to create when you installed the 
application.    You use the company information windows to enter information about existing 
companies such as:

· name and address information
· telephone and fax numbers
· federal and state employer identification numbers
· state unemployment ID

You can change company information at anytime.

Related Topics
 

Set up a company
Company defaults
Changing company Information
Deleting a company
Opening a different company



Change Company Information
 
To change company information:

Select Company Information from the Maintain menu. The following screen will be 
displayed.

                           

Click the Edit button to place the form in the edit mode.

NOTE: All Membership DataBank for Windows data entry forms are 
initially displayed in view mode.

Change/enter the appropriate company information.    When you're finished changing 
information, click the Save button to record the changes permanently in the database.

Fields
Company
Address
City, St, Zip
Telephone
Fax
Federal Employer ID
State Employer ID
State Unemployment ID 



Delete a Company
 
To delete a company:

1. Select Delete Company from the File menu.

2. Select a company file name by highlighting it in the list box.

3. Click Ok to delete the company.    Membership DataBank for Windows prompts you to 
confirm the deletion.    Choose continue to delete the company data files.



Opening a Company
To open a company:

1. Select Open Company from the File menu.

2. Select a company file name by highlighting it in the list box.

3. Click Ok to open the company.



Set Up a Company
To set up a new company:

Select New Company from the File menu. The following screen will be displayed.

                                   

Enter the appropriate company information.    When you're finished entering 
information, click the Ok button.    The company data files will be created and the 
company will be opened for processing.

Fields
Company
Address
City, St, Zip
Telephone
Fax
Federal Employer ID
State Employer ID
State Unemployment ID 



Setting up printers
In Membership DataBank for Windows, most questions concerning printing are answered by 
how you have your environment set up.    In windows, you install printers and specify which 
ones are active on which of your ports. Because of this ability, you can easily switch back 
and fourth between printers.

Though you use the Windows Control Panel to install printers, Membership DataBank for 
Windows gives you access to your printer setup for changing default printers and settings.

To set up a printer:
1. Select Printer Setup from the File menu.

2. Click the Specific Printer radio button.

3. Select a printer from the drop-down list of installed printers.

4. Change any other settings as needed.    These settings vary depending on the types 
of printer you have installed.    See your Windows manual for instructions on using the
Control Panel.

5. Click Ok to save your changes to disk.



Customer Comments
Upgrades to Membership DataBank for Windows and other X-Ware Engineering software are 
based on feedback from our customers.    If you feel that there is a feature missing from 
Membership DataBank for Windows, or that it could be improved upon in any way, then 
please let us know.    At X-Ware Engineering, our aim is to make the products our customers 
want to use!



Getting Started
Introducing Membership DataBank for Windows 
We thank you for using this product.    Membership DataBank for Windows is a database 
application that combines data collection and retrieval using a graphical user interface.    It 
has a rich feature list such as exhaustive information storage, user definable fields, and pre-
defined reports.

Information is easily entered and retrieved.    Many fields have list boxes that allow the user 
to click on the desired information instead of having to enter it manually.

Setting Up the Program 
Before you set up Membership DataBank for Windows, please do the following:

· Make a backup copy of your installation disks.    Although, you shouldn't have any 
problems setting up Membership DataBank for Windows on your computer, a backup copy
will protect you in case the original disks get damaged.    You can copy the disks using 
Microsoft Windows,    the DOS DISKCOPY command, or any other diskcopy program that 
you own.

·
· Become familiar with Microsoft Windows.    In this User's Guide, we assume that you know 

how to use basic Windows features, such as pull-down menus, Minimize button, Maximize 
button, the Control menu, and a mouse.

 
· If you purchased this product directly from X-Ware Engineering, you are automatically a 

registered user.    If you received this product from a friend, colleague, disk distributor, or 
BBS and intend to use it after the evaluation period, please take a few minutes now to fill 
out the enclosed registration form.    After we receive it, you will be sent the most current 
version of the product and be entitled to receive free technical support, product update 
notices, and new product announcements.

System Requirements
In order to setup and operate Membership DataBank for Windows successfully, your 
computer system must meet the following minimum system requirements:

Hardware - Personal computer (IBM PC, PS2, or 100% compatible)
- 386sx or higher microprocessor
- 4 MB of memory (8 MB recommended)
- 6 MB free disk space (10 MB recommended)
- One 3.5" high-density disk drive
- Microsoft Mouse or compatible pointing device
- Any Microsoft Windows supported printer
- VGA or higher-resolution monitor recommended

Software - MS-DOS operating system version 3.1 or later
- Microsoft Windows operating system version 3.1 or later
( running in 386 enhanced mode )

Network - Microsoft Windows For Workgroups 3.11 or later



- Microsoft Windows NT
- Novell NetWare
- Lantastic NOS
- Other NetBIOS compatible networks

In addition, ensure that your C:\CONFIG.SYS file contains the command FILES=60 or above 
to avoid experiencing the error message "Too Many files Open". If you wish to have several 
Windows applications open simultaneously, you may need to increase this value to 100 or 
more.
 

Running Setup
After making a backup copy of the original disks, follow these steps to successfully setup 
Membership DataBank for Windows onto your computer system:

1. Start up Microsoft windows.    If you have any other applications running, close at this 
time.

2. Insert Setup Disk 1 into a floppy drive (A: or B:), select File menu from the Program 
Manager, and choose Run.

3. In the Command Line field of the Run dialog box, type A:SETUP (or B:SETUP if you put 
the disk into drive B:) and click OK.

4. Make sure you follow the instructions that appear on your screen.    The setup program 
will place the program files into a directory called MDBANK, unless you choose a 
different directory.

The README file
A README file has included on the setup disks.    It contains the latest information not 
available when this User's Guide was printed.    This file will automatically be copied into the 
MDBANK directory, or the one you have chosen.    You can read this file at anytime by using 
WRITE or some other word processor.

Starting and Exiting The Program
To start Membership DataBank for Windows:

1. Run Microsoft Windows.

2. Open the program group that contains Membership DataBank for Windows.    the 
default group created when you set up the program is Membership DataBank for 
Windows.

3. Double click on the Membership DataBank for    Windows icon.    The Membership 
DataBank for Windows main menu screen will appear.

4. When you are finished using Membership DataBank for Windows, exit the program 
ether by selecting the Exit option from the File menu, or selecting Close option from 
the Control menu.



Exiting The Program
There are several ways to exit Membership DataBank for Windows: 

· Choose the Exit option from the File Main Menu.
·

· Choose the Close option from the Control-menu box.



Determine General Defaults
Membership DataBank for Windows uses defaults to reduce the number of keystrokes 
required for data entry, thereby saving you a considerable amount of time as you build your 
data files. By defining default terms or values ahead of time, you avoid having to repeat the 
same information again and again for each record in your database.

Company defaults
Member defaults



Getting Acquainted with Screens
As you begin working with Membership DataBank for Windows, you will see several different 
kinds of screens on the monitor.    As you scan the following paragraphs, which describe the 
screens, you will see that a number of different screens are available for a variety of 
purposes.    You will quickly learn to distinguish one kind of screen from another. 

Parent Window
Data Entry Window
Browse Window



Members
The Members module of Membership DataBank for Windows lets you create and maintain 
detailed information about members of your organization, as well as people who are 
nonmembers but are associated with the organization in some way. (For example, you might
want to accumulate information on visitors, guest speakers, and others.)

You use the Maintain Member Information window to enter/change information about 
new/existing members such as:

· basic member information
· household information
· employer information
· member profile information
· comments

You can change member information at anytime.

Tabs
Member 
Profiles
Household
Employer
Comments

Related Topics
Add a new member
Change an existing member
Delete a member
Move a member to a new household
Search for a member



Copyright (c) 1995 X-Ware Engineering.    All rights reserved.
Membership DataBank for Windows is a registered trademark of X-Ware Engineering.    
Membership DataBank for Windows is copyright (c) 1995 by X-Ware Engineering.    All rights 
reserved.

Microsoft, Microsoft Mouse, MS-Dos, and Windows are either trademarks or registered 
trademarks of Microsoft Corporation.

IBM is a registered trademark and PC is a trademark of International Business Machines.

Information in this document is subject to change without notice.    Companies, names, and 
data used in examples herein are fictitious unless otherwise noted.    The software and/or 
databases described in this document are furnished under a license agreement or 
nondisclosure agreement.    The software and/or databases may be used or copied only in 
accordance with the terms of the agreement.    It is against the law to copy the software 
except as specifically allowed in the license or nondisclosure agreement.    No part of this 
document may be reproduced in any form whatsoever (except as permitted within the 
license agreement) without the express written permission of X-Ware Engineering.



About Membership DataBank for Windows
Displays your license number and information about your version of Membership DataBank 
for Windows.



search for help on
A dialog box for locating information about a specific topic.



using help
Information about how to use Windows help.



arrange icons
When you minimize a desktop window, it becomes an icon.    You can move these icons 
around in the desktop workspace by dragging them with a mouse.    If you have many of 
these icons in your desktop, you can arrange them so that they are evenly spaced and don't 
overlap.



cascade windows
Desktop windows overlap, starting in the upper-left corner of the desktop workspace.    each 
window's title remains visible, making it easy for you to select any of the desktop windows.



tile window horizontally
Windows are resized and arranged horizontally (side-by-side) so that no windows overlap 
and each window's contents are visible.



tile window vertically
Windows are resized and arranged vertically (on top of each other) so that no windows 
overlap and each window's contents are visible.



Parent Window
The Membership DataBank for Windows application uses a multiple-document interface 
(MDI) that maintains multiple forms within a single container form.    This type of interface 
allows users to to display multiple documents at the same time, with each document 
displayed in its own window.    Document windows are contained in a parent window, which 
provides a workspace for all document windows in the application.

  

Elements of the Parent Window
·     Title Bar   - Along the very top of the screen is a horizontal bar that contains the name 

Membership DataBank for Windows.    Each time you open a company or create a 
new one, this bar will be updated to display the active company in use.

·     Menu Bar   - Along the top of the screen under the Title bar is another horizontal bar 
listing the Main Menu options: File, Edit, Maintain, Reports, Options, Window, and Help. 
When you select any of these options, a pull-down menu appears listing choices for the
Main Menu option.    If one of these options is dimmed , this means that it is not active 
for that particular program function.    Membership DataBank for Windows 
automatically updates the menu bar depending on the program functions.

·     Toolbar   - Just below the Menu Bar is the Toolbar.    This is a unique button bar that 
allows quick access to program functions that are common to all windows.    It is 
specially designed to be easy to locate and use by    a picture and/or text describing 
what the button does.

·     Status Bar   - Along the bottom of the screen is a horizontal bar that displays status 
information such as information/status messages, the current processing date, and the
current accounting period.



Copy
 
Copy places selected text or graphics on the clipboard without removing the selection from 
your document.

To copy text or graphics,

1. Select the text or graphics (or both) you want to copy. 

2. Choose Copy from the Edit menu.

You can then Paste the clipboard contents into a document by choosing Paste from the Edit 
menu.    The selection remains on the Clipboard until you use Cut or Copy to replace it with a 
new selection or until you quit Windows.



Cut
Cut removes selected text or graphics from your document and places it on the Clipboard.

To cut text or graphics,

1. Select the text or graphics (or both) you want to cut. 

2. Choose Cut from the Edit menu.

You can then Paste the clipboard contents into a document by choosing Paste from the Edit 
menu.    The selection remains on the Clipboard until you use Cut or Copy to replace it with a 
new selection or until you quit Windows.



Paste
Paste places text or graphics from the Clipboard into your active document at the insertion 
point.

To paste,

1. Place the insertion point where you want to paste the clipboard contents.
 

2. Choose Paste from the Edit menu.



Data Entry Window
You use data entry screens to build your data files.    A data entry screen comprises a series 
of fields, into which you type the appropriate information.    The information entered is 
processed by Membership DataBank for Windows to build the file and reports required by 
your application.

Although data entry screens do not all look exactly alike, they do reflect a common layout 
pattern and share some common components.

           

Elements of the Data Entry Window
·     Title Bar   - Along the very top of the screen is a horizontal bar that contains the name 

of the data entry window.    The title typically identifies the primary function of the data
entry window.

·     Toolbar   - Just below the Title Bar is the Toolbar.    This is a unique button bar that allows
quick access to program functions that are specific to the data entry window.    It is 
specially designed to be easy to locate and use by    a picture and/or text describing 
what the button does.

Summary of Toolbar Buttons
 

                       - Move record pointer to the beginning of the file.

                       - Move record pointer to the previous record in the file.



                       - Move record pointer to the next record in the file.

                       - Move record pointer to the end of the file.

  - Open a window for browsing/searching records.

                       - Place a data entry window in a edit mode so that data fields 
may be

    entered or modified.
  - Delete the current record.

  - Create a new record.

  - Save changes to a new or existing record and place the data entry 
window

      in the view mode.    This button is only active when the data entry 
window is

      in the edit mode, otherwise it is disabled (dimmed).
  - Cancel the current edit session, all changes are discarded.    This 

button is
      only available when the data entry window is in the edit mode.

  - Close the data entry window.    This button is only available when the 
data

      entry window is in the view mode.

  - Display context sensitive help.



Browse Window
Browse screens let you see a lot of data on one screen.    Several browse screens are built 
into Membership DataBank for Windows so that you can quickly access the appropriate 
member, group, meeting, contribution, pledge, fund or deposit information.

Although browse screens do not all look exactly alike, they do reflect a common layout 
pattern and share some common components.    An example of a browse screen is shown 
below.

                         

Elements of the Browse Window
·     Title Bar   - Along the very top of the screen is a horizontal bar that contains the name 

of the browse window.    The title typically identifies the primary function of the browse 
window.

·     Toolbar   - Just below the Title Bar is the Toolbar.    This is a unique button bar that allows
quick access to program functions that are specific to the browse window.    It is 
specially designed to be easy to locate and use by    a picture and/or text describing 
what the button does.



Custom Fields
You can enter up to 20 characters of information for each custom field.



special event dates
This is a numeric field that must be entered as MM/DD/YYYY.    Example: 01/01/1995.



additional telephones
you can enter up to 20 characters for each additional telephone number.



access authorization
To control the right to enter or view application data items.



accounts payable
Obligations to pay for goods or services that have been acquired on open account from 
suppliers.    Accounts payable is a current liability in the balance sheet.



accrual accounting
Recognition of    revenue when earned and expenses when incurred.    They are recorded 
during an accounting period even though cash has not been received or paid.    This presents
a truer picture of of income and expenses.    An example of accrued revenue is dividend 
income earned on stock owned though it has not yet been received.    Accrued salary 
expense due employees at period-end is an example of an accrued expense.



application
A computer program used for a particular kind of work, such as word processing, database 
management, spreadsheet calculations, or accounting.    This term is often used 
interchangeably with "program".



bank    balance
Amount in    a bank deposit account, such as a checking or savings account, as of a certain 
specified time or date, indicated on a bank statement.    Bank charges, deposits in transit, 
and outstanding checks usually are primary factors in reconciling an individual's or 
organization's books and the bank's statement, as of a particular date.    See also BANK 
RECONCILIATION.



bank reconciliation
Term used when settling differences contained in th BANK STATEMENT and the cash account 
in the books of the bank's customer.    Rarely do the ending balances agree.    To reflect the 
reconciling items, a bank reconciliation is required.    Once completed, the adjusted bank 
balance must prove to the adjusted book balance.    When it does, it indicates that both 
records are correct.    Journal entries are then prepared to update the records and to arrive at
an ending balance in the cash account that agrees with the ending balance in the bank 
statement.

The bank balance is adjusted for items reflected on the books that are not on the statement. 
They include OUTSTANDING CHECKS, DEPOSITS IN TRANSIT, and bank errors in charging or 
crediting the company's account.

The book balance is adjusted for items shown on the bank statement that are not reflected 
on the books.    They include bank charges, not-sufficient funds, checks, collections made by 
bank on customer's behalf (e.g., collected notes receivable), interest earned, and errors on 
the books.



check box
a small, square box that appears in a dialog box or data entry window and that can be 
selected or cleared.    When the check box is selected, an X appears in the box.    A check box
represents an option that you can turn on or off.



click
To press and release a mouse button quickly.



clipboard
An area of memory, also called a buffer, where text and commands can be stored to await 
further action.    The contents of the Clipboard are erased when you exit Windows. 



command button
A button in a dialog box, data entry window, or browse window that carries out or cancels 
the selected action.    Two common command buttons OK and Cancel.    Choosing a command
button that contains an ellipsis (for example, Browse...) causes another dialog box to appear.



contribution
A donation made to the organization, often for a specific fund.



Control menu
A menu that contains commands you can use to manipulate a window.    To open the the 
Control menu, you choose the Control-menu box at the left of the title bar in a window, or 
you select an application icon at the bottom of the desktop.    Every application that runs in a
window and some non-Windows applications have a Control menu.    document windows, 
icons, and some dialog boxes also have Control menus.



Control-menu box
The icon at the left of the title bar.    This icon opens the Control menu for a window.



default button
In some dialog boxes, the command button that Windows automatically selects.    The 
default button has a bold border, indicating that it will be chosen if you press ENTER.    You 
can override a default button by choosing the Cancel button or another command button.



dialog box
A window that appears temporarily to request or supply information.    Many dialog boxes 
have options you must select before Windows can carry out a command.



dimmed
Unavailable, disabled, or grayed.    A dimmed button or command is displayed in light gray 
instead of black, and it cannot be chosen.



document
Whatever you create with an application, including information you type, edit, view, or save. 
A document may be a business report, a spreadsheet, or a picture, for example.



document window
A window inside an application window.    Each document window contains a single 
document or other data file.    In some applications, there can be more than one document 
window inside an application window.



double-click
To rapidly press and release a mouse button twice without moving the mouse.    Double-
clicking carries out an action, such as starting an application.



title bar
The horizontal bar (at the top of the window) that contains the title of the window or dialog 
box.    On many windows, the title bar also contains the Control-menu box and Maximize and 
Minimize buttons.



fund
1. Cash, securities, or other assets designated for a purpose such as in a SINKING FUND.

2. In GOVERNMENT ACCOUNTING, fiscal and accounting entity with a self-balancing set of 
accounts recording cash and other financial resources, together with related liabilities 
and residual equities or balances, and changes therein.    Funds are segregated for the 
purpose of conducting specific activities or attaining certain objectives in accordance 
with special regulations, restrictions, or limitations.    An example is the SPECIAL 
REVENUE FUND.    See also FUND ACCOUNTING.

3. As a verb, to finance, using long-term debt, usually bonds.



fund accounting
System used by nonprofit organizations, particularly governments.    Since there is no profit 
motive, ACCOUNTABILITY is measured instead of profitability.    The main purpose is 
stewardship of financial resources received and expended in compliance with legal 
requirements.    Financial reporting is directed at the public rather than investors.    The 
accounting equation is Assets = Restrictions on Assets.    Funds are established to ensure 
accountability and expenditure for designated purposes.    Revenues must be be raised and 
expended in accordance with special regulations and restrictions.    Budgets are adopted and
recorded in the accounts of the related fund.    Contractual obligations are given effect in 
some funds.



edit
To make changes, additions, deletions, or rearrangements, or to change data in any manner 
before making permanent.



encumbrance
1. In government accounting, commitments related to unfilled contracts for goods and 

services including purchase orders.    The purpose of encumbrance accounting is to 
prevent further expenditure of funds in light of commitments already made.    At year-
end, encumbrances still open are not accounted for as expenditures and liabilities but, 
rather, as reservations of fund balance.    When an estimated or contractual liability is 
entered into, the entry is to debit encumbrances for the estimated amount and credit 
RESERVE FOR ENCUMBRANCES.    When the actual expenditure of an amount previously
encumbered is known, there are two entries.    The first is to reverse the original 
encumbrance.    The second entry is to record the expenditure by debiting expenditures
and crediting VOUCHERS payable.    At year-end, the encumbrance account is closed 
out against fund balance.

2. Debt secured by a lien on assets.



expense
Results from or measures the using up of an asset (e.g., depreciation) or incurrence of a 
liability (e.g., warranty expense) to obtain revenue in the current period.    An expense can 
apply to the cost of merchandise sold or services rendered.    Expenses apply to the ordinary 
course of business (e.g., salary expense) rather than to incidental transactions (e.g., fire 
loss).    Expenses are deducted from the revenue to derive net income.    An expense account
is maintained for each type of expense for control purposes.    See also COST; LOSS.



group
Within an organization, a collection of individuals who belong together because of 
objectives, interest, etc., held in common.



hard copy
Computer term for output printed directly on paper. 



icon
A graphical representation of an element in Windows, such as a disk drive, directory, group, 
application, or document.    you can enlarge an application icon to a window when you want 
to use the application.



journal entry
Record of the accounting information for a business transaction.    The entry is made in a 
journal and then posted to a ledger.    The journal entry has a date, account(s) debited, and 
account(s) credited.    If there is more that one debit or credit, it is referred to as a compound
entry.    Total debits must equal total credits.    The journal entry is accompanied by a short 
description.



kiting
A term used in banking circles to describe the illegal practice in which a cash shortage is 
concealed by exploiting the time required for a check to clear.



liability
Amount payable in dollars (e.g., accounts payable) or future services rendered (e.g., 
warranties payable).    The party having the liability is referred to as the debtor.    There are 
various types of liabilities.    An actual liability actually exists and has a stated amount (e.g., 
bonds payable).      An ESTIMATED LIABILITY also actually exists, but the amount must be 
predicted (e.g., estimated tax liability).    These liabilities are booked and are shown in the 
balance sheet as credit balances under    current or noncurrent liabilities, depending on 
whether they will be paid in a period of more or less than one year.    A CONTINGENT 
LIABILiTY is one that may not become due (e.g., notes receivable discounted; a pending a 
lawsuit).    A contingent liability is usually footnoted in the financial statement.



maximize
To enlarge a window to its maximum size by using the Maximum button (at the right of the 
title bar) or the Maximize command on the Control menu.



Maximize button
The small button containing an up arrow at the right of the title bar.    Mouse users can click 
the Maximize button to enlarge a window to its maximum size.    Mouse users can use the 
Maximum command on the Control menu.



member
Individual(s) admitted as an official participant in an organization.



menu
A list of available commands in an application window.    the Control menu, represented by 
the Control-menu box at the left end of the title bar, is common to all Windows applications.  
You open a menu by selecting the menu name.



menu bar
The horizontal bar containing the names of all the application's menus.    It appears below 
the title bar.



minimize
To reduce a window to an icon by using the Minimize button (at the right of the title bar) or 
the Minimize command on the control menu.



minimize button
The small button containing an down arrow at the right of the title bar.    Mouse users can 
click the Minimize button to reduce a window to an icon.    Mouse users can use the Minimize 
command on the Control menu.



toolbar
Bar    displaying buttons to perform program functions.



modified accrual
Governmental accounting method.    Revenue is recognized when it becomes available and 
measurable.    Expenditures are typically recognized in the period in which the liability is 
incurred except for: ( 1) inventories of materials and supplies that may be considered 
expenditures either when bought or used; (2) interest on general and special assessment 
long-term debt that is recognized on the date due; (3) use of encumbrances.    Most 
governmental funds follow the modified accrual method.    See also ACCRUAL ACCOUNTING.



non-profit accounting
Accounting, policies, procedures, and techniques employed by NON-PROFIT 
ORGANIZATIONS.    Non-profit accounting is somewhat different for governmental units than 
for nongovernmental units (i.e., colleges, hospitals, voluntary health and welfare 
organizations, and charities).    Governmental units employ fund accounting , which 
measures ACCOUNTABILITY rather than profitability.    The MODIFIED ACCRUAL basis is 
typically employed by governmental funds.    Nongovernmental units use the accrual basis.



non-profit organization
Group, institution, or corporation formed for the purpose of providing goods and services 
under a policy where no individual (e.g., stockholder, trustee) will share in any profits or 
losses of the organization.    Profit is not the primary goal of non-profit entities.    Profit may 
develop, however, under a different name (e.g., surplus, increase in fund balance).    Assets 
are typically provided by sources that do not expect repayment or economic return.    Usually
there are restrictions on resources obtained.    Examples of non-profit organizations are 
government, charities, universities, religious institutions, and some hospitals.    Most non-
profit organizations have been granted exemption from federal taxes by the Internal 
Revenue Service.    Many of these organization refer to themselves according to the IRS Code
section under which they receive exempt status (i.e., 502(c)(3) organization).    This 
identification lets donors know that their contributions to this organization may be 
deductible for income tax purposes.



outstanding check
One issued by the company but not yet cleared by the bank.    It is listed in the cash 
payments journal for the month but is not included on the bank statement for that month.    
In preparing the bank reconciliation, it is deducted from the bank balance.    



pledge
A promise to give a monetary amount to an organization or an organization's fund over a 
particular time period (e.g., daily, weekly, monthly, or yearly).



quarterly report
Financial report issued every three months between annual reports.    It includes unaudited 
financial statements consisting of the balance sheet, income statement, and statement of 
changes in financial position along with related footnotes.      Also, typically there is a 
narrative overview of business operations.      



receipts
1. Cash or other assets received.
2. Evidence substantiating the occurrence of an event.    Accounting documents showing 

receipt include a receiving report of merchandise or a bill for an expenditure incurred 
(e.g., hotel bill, restaurant check)>



scroll bar
A bar that appears at the right and/or bottom edge of a window or list box whose contents 
are not completely visible.    Each scroll bar contains two scroll arrows and a scroll box, which
enable you to scroll through the contents of the window or listbox.



shareware
Software that is sold by individuals or small companies for a nominal fee.    Typically buyers 
download shareware from computer bulletin boards and try it out before buying and 
registering it.    Registration entitles buyers to user manuals, support, and discounts on 
future upgrades.



status bar
A line of information usually located at the bottom of a window.    In Membership DataBank 
for Windows, the status bar show information/status message, the current process date, and
the current accounting period.



unadjusted trial balance
One showing account balances in debit and credit columns prior to preparing an ADJUSTING 
JOURNAL ENTRY.



user-definable
A field that you design to store information that is unique to your organization.



view
To observe on the computer's screen.



warning beep
The sound that your computer makes when you encounter an error or try to perform a task 
that Windows does not recognize.



window
A rectangular area on your screen in which you view an application or document.    You can 
open, close, and move windows, and change the size of most windows.    You can open 
several windows at a time, and you can often reduce a window to an icon or enlarge it to fill 
the entire desktop.



Windows application
"Windows application" is used as a shorthand term to refer to an application that is designed
to run with Windows and does not run without Windows.    All Windows applications follow 
similar conventions for arrangement of menus, style of dialog boxes, and keyboard and 
mouse use.



xsim
on-line corporate modeling system developed by Dynamics Associates, Cambridge Mass.    
Like IFPS and SIMPLAN, XSIM is a comprehensive modeling systen with analytical 
capabilities.    It generates pro forma financial statements and budgets and helps answer a 
variety of what-if questions.



year-end adjustment
process of adjusting the entry to an account at the end of the calendar or fiscal year ib order
to properly state it for financial statement purposes.    Types of required adjustments include 
accural or deferral of a revenue or expense item, reclassification, adjustments to conform 
book figures to physical counts (i.e., inventory), and reflecting unusual transactions.



zero-base budgeting
planning and budgeting tool that uses COST-BENEFIT ANALYSIS of projects and functions to 
improve resource allocation in an organization.    Traditional budgeting tends to concentrate 
on the incremental change from the previous year.    It assumes that the previous year's 
activities and programs are essential and must be continued.    Under zero-base budgeting, 
however, cost and benefit estimates are built up from scratch, from the zero level, and must 
be justified.
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Toolbar Summary
Summary of Toolbar Buttons
 

                       - Move record pointer to the beginning of the file.

                       - Move record pointer to the previous record in the file.

                       - Move record pointer to the next record in the file.

                       - Move record pointer to the end of the file.

  - Open a window for browsing/searching records.

                       - Place a data entry window in a edit mode so that data fields 
may be

    entered or modified.
  - Delete the current record.

  - Create a new record.

  - Save changes to a new or existing record and place the data entry window
      in the view mode.    This button is only active when the data entry 

window is
      in the edit mode, otherwise it is disabled (dimmed).

  - Cancel the current edit session, all changes are discarded.    This button is
      only available when the data entry window is in the edit mode.

  - Close the data entry window.    This button is only available when the data
      entry window is in the view mode.

  - Display context sensitive help.



Customizing Report Output 
When your file contains many records, it can be more helpful to restrict what is printed on 
the report to only those records relevant to the desired report.    By excluding all non-
relevant records, the process of selecting the records you want is simpler.

For Example, if you want to print a report on all members whose contributions are above a 
certain level, it's better to restrict the report to those members meeting that criterion.    After
all, without viewing each individual member account, how do you know which ones to 
select?

The key to this method of selecting sets of records is the Custom button.

When you choose Custom output, Membership DataBank displays a window whose fields 
vary depending on the report option you're using (but the principle behind its operation is 
the same). The information provided here is based on the dialog box associated with 
member record selection criteria

Fields

Notice the dialog box displays the    names of various fields normally associated with 
membership accounts, along with a check box.    You can click on any check box (or move 
your highlight to it and press the Spacebar) to mark it with a check mark.    Doing so includes
that field in the selection process.    For example, marking the envelope field allows you to 
select customer records which fall between a certain range of envelopes.

You can use as many fields as necessary to define selection criteria -- the more precise your 
criteria, the more specific the list of records.

 
Criteria

The next row of boxes selects the way the criteria sorts.    When you click on these boxes, the
type of criteria shown changes:

Criteria Meaning
> greater than
< less than
<> between two values
* starts with
= equal to
!= not equal to

The last two items are only available for text fields, such address, Zip Code, description, etc. 
The "between" option (<>) can only be used when there are two boxes in the Values 
column.    When you enter a range of values in the form of an upper and lower limit, the 
resulting search includes the desired range plus the upper and lower limits themselves.

Values

In the values boxes, you can enter some meaningful characters or numbers which, when 
used with the criteria, help to define the selection of desired records.



Some fields have two entry boxes which define a range of numeric values.    Here are some 
examples defining criteria:

Field Criteria Value(s) Action

Zip Code * 94 Selects all records whose zip codes 
begin with 94.

Envelope # > 8000 Selects all records whose Envelope # field 
is greater than 8000.

Registry # <> 200    600 Selects all records whose Registry # 
is between 200 and 600 (inclusive).

Gender = Male Selects all records whose Gender 
field is Male.

Member != Deceased Selects all records whose Member Status 
Status field isn't Deceased.

You can choose any criteria to define the type of records shown.    When you click Continue, 
Membership DataBank selects records on the basis of the specified criteria and prints the 
records matching the criteria.    If no records are printed, you specified criteria for which 
there is no match.



display household summary information
Choose this option to display a browse window that list all the members of a household 
(residence).    



assign this person as head of household
Choose this option to assign the current member as the head of household for the 
associated residence.



pick new household for this person
Choose this option to assign the current member to another another household that already 
exists in the Membership DataBank database.



create new household for this person
Choose this option to create a new household (residence) in the Membership DataBank 
database.    The current member is automatically assigned as the head of houehold for the 
new residence.




